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Introducing SMART Notebook 11.4

SMART Notebook software is now faster and better than ever, with an
intuitive ink experience and support for more operating systems.
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New features in SMART Notebook 11.4

Alignment Tools add-on

Use the new Alignment Tools add-on to align and distribute
objects on the SMART Notebook page. You can align objects on
the bottom, left, right or top, as well as vertically or horizontally.
You can also align stacked objects vertically or horizontally.

To start, select multiple objects on the page, press the Add-ons
button in the toolbar and then press an alignment option.

Alignment options available on your toolbar can be customized.

How to customize your toolbar

Try it
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New features in SMART Notebook 11.3

Drop Cap support

Add decorative initials to the beginning of any paragraph.

This button is available in the Properties tab, under Text Style.
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Oncz upon a timg thereg was a dear littlg girl who was

loved by gvergong who looked at her, but most of all by her
grandmother, and therg was nothing that shg would not have
given to the child. Oneg she gave her a littlg cap of red
velvet, which suited her so well that she would ngver wear
anything ¢lse; so she was always called 'Little Red-Cap.'

- introduection to "littlg Red Cap" by The Brothers Grimm
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New features in SMART Notebook 11.2

Toggle the zoom level

Switch quickly between the two most common zoom levels,

Entire Page and Page Width, by adding this button to your
toolbar.
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Entire Page/Page
Width Display

This button is also available on the Full Screen toolbar. [z
= . Haanm -

How to customize your toolbar

.
SMART Notebook Preferences | | M =]

| General | Defautts | SMART Response |

Image optimization

[ sk every time linsert @ large image ]

e = Change the default page background color
i

T Defaut background color for new pages

Cumrent default I Change Calor ;
Mte: This setting affects new pages I I I I I O IO I |ormes you
apoly AEEEEEEEN
More information EEEECOEEN
OEOEECOER

Measurement tool color Ol DDD EOD

oo o b 2 Mo - .
— How to edit your Preferences

Table cell padding
Add cell padding to table cells

Mote: This setting affects new and existing tables. It will take effect the next time you start
SMART Notebook software.

Mare information

You can change the default page background
color in SMART Notebook Preferences.

[\

Looking for add-on preferences? Try the Add-on Manager |

o] [omat] |
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New features in SMART Notebook 11.2

S Turn off Extend Page
e Ba Opbons : ‘ Prevent your pages from becoming longer by
® l .
Ertend Page B turning off Extend Page.
—— | Access this option from View > Extend Page.
( Fill Effects ]
. . . [ Line Style |
Customize ink fade times | Poge Aeosrdieg |
You can type in a custom value for ink fade time. MW N

Remember to press Save Tool Properties to save
your changes as a default ink style on the toolbar.

| Enable ink to fade after you write it

Fade after (seconds)

Save Tool Properties ]
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Write and draw

Pick up a pen and write
Press a pen color button on the pen tray to change the pen color.

Writing on your SMART Board® interactive whiteboard

On-screen keyboard
Press the Keyboard button to launch the
on-screen keyboard.

Right-click
To make your next touch a right click, press
the Right-Click button on the pen tray.
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Adaptive toolbar

The toolbar provides shortcuts to
commonly used actions, tools and

properties. When you use the Select

tool to select an object in the work
area, its properties appear to the
right of the tools group.

Press to reveal

Actions - Properties
/—\_/% /_\_’/H
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Remember

« You can still find additional
properties in the Properties
== tab and in the object’s
drop-down menu.
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Clone
Cut
Copy
Paste
Delete

Infinite Cloner

SetImage Transparency...

Optimize Image...

Lock

Group

Flip

Order
Link...
Sound...
Properties...

Ctrl+D
Ctrl+X
Ctrl+C
Ctrl+V

Del
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Improved toolbar customization

Customize the toolbar so that the buttons you use frequently are only one click away.
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Pages

A See and sort your pages
@ Use the Page Sorter tab to jump to a page by
o

— Z selecting its thumbnail, or reorganize your pages
) Ewa by dragging them into a different order.
P What's new Reset Page
| Easily reset your page to its last saved state, without
reopening your lesson file.
a3 PEring ¥
i— L=~ I
& ~ |7 |
_ Insert Blank Page Ctrl+M
PR E Clone Page Ctrl+D
a Rename Page
— N Delete Page Del
A— { L) B Clear Page Ctrl+L
= Clear Ink from Page
Adapte Toolbar
Mov 28-3-30 P Screen Shade
Set Background Fill...
8 Remove Theme
Show All Links Alt+L

Add Page to Gallery
New ?78-3-30P T
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Objects

Resize and rotate

Press the leaf to select.

To rotate, use the green handle.
To resize, use the white handle.

' V4

Move objects
Press the leaf and drag it to
move it around the page.

Remember

S

To select an object, switch back to Select mode by &
putting down the pen and then pressing the Select icon. A /9
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Text objects

Add text
Click the Text button on the toolbar,
and then click the work area to create

a text box. Start typing. '

You can format text using the buttons
in the toolbar or the options in the
Properties tab or the Format menu.

Press to reveal

Edit text
Double-click the text box to edit text. .

Resizing the text box

Drag the white handle to adjustthe  / Try it here! Double-click the text
length of the text box and reflow the to the left and use the white
text inside. handle to adjust the text box.

12
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Gallery content

Find content in the Gallery
E Find images, videos, sound files, interactive activities, backgrounds
and SMART Notebook pages in the Gallery. Just drag and drop to

add them to your page.
E 4 [Typesearcn temshere <] P Souch
> O 52 e e :
Add interactivity with the Lesson Activity Toolkit £ - ]
. a Zr;gahgsr:::: Language Arts
J— The Gallery tab also con_tglns templates to help C g@ Y
you create your own activities and engage your - — .
ﬁ students with interaction. al| EF
4 |Pictures (657)
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Notebook Gallery 2.0 Beta

Test-drive the Notebook Gallery 2.0 Beta and search both online and offline Gallery
resources with ease.

..ﬂ Gallery Es=sentials a- C“Ck here
f-54 Lesson Activity Toolkit 2.0 to download
..ﬂ Lesson Activity Examples

..{% SMART Exchange H

L.

i i Notebook Gallery 2.0 B-etaE

Click the link in the Gallery to visit the

Notebook Gallery 2.0 Beta channel,
where you can learn more about the
beta program and how to participate.

Preview
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Sound recorder

Record a short sound clip to attach to an object on the page.

¢

‘J Clone
Cut
Copy
Paste
Delete

Infinite Cloner

Show/Hide Vertices
Show/Hide Interior &ngles
Show/Hide Side Lengths
Divide Shape...

Check 5pelling...

Lock
Group
Flip
Order

Properties...

Ctrl+D
Ctri+X
Ctrl+C
Ctrl+¥

Del

”
Insert Sound

(9 o

From file

E Sound to play:
| |

| Browse... |

R und dip
L Current recarding length:

00:00 Start Recording

q @ Recording name:
N
wdings can't be longer than 01:00. /

Preview Sound

Play by pressing: @ Cormericon () Object

Remove Sound

Attach Sound | [Canoel ] ’ Help ]
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Activity Builder

Create interactive lesson activities easily by using the Activity Builder. To
start, click the Add-ons tab, and then click the Activity Builder thumbnail.

Try it What do horses eat?

Drag and drop foods over the horse to feed it.

tad

Use it in your class today

LYY A

& Type search terms here ¥ F

£ Lesson Activity Examples ~| Need some inspiration? There are many
- more activity examples in the Gallery.

- Interactive Technigques H

.= Trimble 30 warehouse
.2 Notebook Gallery 2.0 Beta i

16



Tutorial for SMART Notebook 11.4.notebook

B rowse r Press to reveal

Browse the Internet without leaving ‘
your SMART Notebook file.

Blank Page Ctrl+M

Picture... -
Picture From Scanner...

Video...

Adobe Flash Player Compatible File...
Gallery Item...

Link...
Sound...
Table...
Graph Table...
Graph...

Equation

N
71N

Meazurernent Tool k

Internet Browser

SMART Document Camera Viewer

SMART Response Question...
SMART Response Title Page...
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Preferences

SMART Notebook Preferences gives you detailed

control over your user experience.

Press to reveal

The customizable settings include the following:

e Changing the default page background
color.

e Enabling or disabling the shake gesture
and the press-and-hold gesture.

» Enabling or disabling hardware
acceleration (disable it if your content
doesn’t display correctly and SMART
Notebook software isn’t responding).

e Changing the measurement tools’
color.

» Adding or removing cell padding in
tables.

r — ——— N
T R, B
e i
General | Defauls | SMART Response |
SMART Motebook is cumently the default program for notebook files.

Make Default

[]Tel me i SMART Notehook softwars isnt the defaukt prodram for notehook filesi

Shake gesture
Use the shake gesture o group and ungroup objects
Press and hold

st I I
Press and beld to pefom) —m M ™ ————————————— —  —

More information on qesture: ‘ General ‘ Defaults |5MAF{T Hﬂponse‘

Image optimization

Hardware 1
[#] Use hardware lﬂﬁﬂwﬁmlmélﬂeiﬂage -]
Note: Tum off hardwars acd| More information
MNotebook software.

Default background color for new pages

R

Note: This setting affects new pages only and is ovemidden by any themes you
apply.
More information

More information

Measurement tool color

[Bue int forlight backgrounds) -]

3
&
——

More information

Table cell padding
Add cell padding to table cells

Note: This setting affects new and existing tables. it will take effect the next time you start
SMART Notebook software

More information

Looking for add-on preferences? Try the Add-on Manager

Restore All Defaulis

| 7]

Access SMART Notebook Preferences from Edit > Preferences
(Windows) or Notebook > Preferences (Mac).
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Download lessons

Download teacher-created lessons from the SMART Exchange™ website

Search by subject and grade. See what other teachers are trying and
loving. Download and modify lessons to suit your teaching style.

S |\/| ART EXC h an g e Signin | Join for free! | BE United States

Find Lesson Plans for Your SMART Board and Connecl t with Teachers
= My cart

“ Search Share a Resource Standards-Aligned Community ¥ Training ¥

Search All Resources

Lessons, ima ges and more

‘-*E“.E“.H@

I IR

Browse by: eXChanqe.S|||artteCh.CO|||
Subject(s) Grade(s) File Type
Art and Design Citizenship Cross-curricu lar English as a Second Language
English Language Arts Geography Health and Physical Education History R H
ICT Library and Infermational Science Mathematics Modem Foreign Languages O p e n th e S MA T EXC h a n g e We bS I te
Music Other Religion Science
Social Studies Special Education

in your web browser or click the
Top Downloads more) Featured Premium resources (more) toolbar icon to go there direCtly.

G ry-Exterior
_:?J;---_!'EL Let's Celetrate!

g

g N

= 0

L J) school

eomet|
les of a Polygon
RT Notebook lesson
dleback Educational Publishing

JEOPARDY!
]

The Mitten 100 days of school Contractions Jeopardy Template for
SMART Notebook lesson SMART Notebook lesson SMART Notebook lesson SMART Response
SHMART Notebook lesson

= Spinner Game Gr.
=\ | PK-2: Algebra
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SMART Board interactive whiteboard

On the following pages, features with this k.3 symbol
are available only on SMART Board 800 series
interactive whiteboards or certain other SMART
hardware products.

Refer to your interactive product’s specifications
(available from smarttech.com/support) to
determine which features it supports.

For additional resources related to your SMART hardware product,
visit smarttech.com/training.

20
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Gestures

Click the buttons to view the ge

21
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Using object awareness

Work more naturally

The interactive whiteboard’s cameras detect the size of your touch and assign different

tools accordingly. This enables you to use your finger or pen to write or select, and your
palm or fist to erase.

Click the box below to view object awareness in action.

Use the pen to write, your finger to drag and
your palm to erase.

Try it here — 7

A video has been created to further explain the concept of object awareness and
touch recognition here: http://youtu.be/IBMdi1XM9mc

i LB |

22
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Lockable pen optionix

Play the video file to view the gesture.

If you want to use your SMART Board interactive whiteboard
with a rolled up sock, Koosh® ball, tennis ball or pointer, enable
the Lockable pen option.

Press and hold a pen color button until it flashes. This
locks the interactive whiteboard so you can use any tool,
not just your finger or pen, with the interactive
whiteboard. Use your tool of choice to write, or press any
toolbar tool to change the tool’s function.

Press another pen color button to disable the Lockable pen
option and go back to using your pen, finger and palm.

23
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Explore other SMART products

Click the products below to learn what's new and more!

SMART Ink

Introducing SMART Ink! m SMART Document Camera™

- SMART Table® collaborative
learning center

g SMART Notebook Math Tools
7T

SMART Response interactive
response software

What's new in SMART Response 2013

u SMART Sync™ classroom
—_"

management software

24
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Now try it yourself

/

SMART Notebook 11

SMART

© 1565 - 3013 SRAART Techinol ogies

Start exploring and creating.

For additional help, tutorials or information on training sessions, use the Help
menu or go to smarttech.com/training.

25
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  Welcome!     Welcome to the SMART  Response™   2013  software What's New guide    Review new features and   get  started quickly                                                               To access this guide later, go to    Then click the  What’s new in SMART   Response 2013  link on the last page.
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  VE persistent IDs     Persistent assessment IDs for   SMART Response VE    Use the same Assessment ID for single or instant questions. Students no longer   need to sign in multiple times!        The Assessment ID    changes only when a   new class is started.  
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  Recent tags       Recent tags    Tag questions faster when you’re reusing the same set of tags:   · Education standards from your local state/province   · Cognitive levels from several popular cognitive level scales   · Custom tags that you create      Easily reuse recently used tags!    
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  VE whole class mode      Whole class mode for   SMART Response VE    Teachers can now choose to deliver their   assessment in self-paced or whole class mode.       In self-paced mode, students can answer all   questions at their own pace (same as in   SMART Response 2012).       In whole class mode, students can answer only   the question that’s displayed on the   SMART Notebook™ page.    
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  What's new     Introducing SMART Response 2013    New features and enhancements   · Easily tag questions with recently used tags   · Create reports based on student or class performance criteria   · Operating system support for Mac OS X 10.8 (Mountain Lion) and Windows® 8      SMART Response VE improvements   · Use the same Assessment ID during a class session – students no longer need to   sign in multiple times (available in SMART Response 2012 SP1)   · Control the pace of the assessment using whole class mode   · Prevent cheating and login errors – students can now sign in from  only  one device   · Support for using SMART Response VE with proxy servers      
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  VE sign-in control     Sign-in control for SMART Response VE    Students can now sign in from  only one  device at a time, which reduces cheating   and sign-in errors.       If a student needs to switch   devices, you can grant him   or her permission to do so. 
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  Performance criteria        Performance criteria for reports    Quickly identify areas   students don’t understand   by generating reports for   students or classes meeting   a specific performance   criteria.   If at least one item meets   the performance criteria,   then a report for that student   or class is generated.  The   report includes only the   subset of items that meet   the performance criteria.
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  Proxy server and operating system support     Proxy server and operating system support    Proxy server support for SMART Response VE   SMART Response VE now works with proxy servers (configured by   your system administrator, if applicable).    Additional operating system support   SMART Response is now supported for:   · Mac OS X 10.8 (Mountain Lion)   · Windows 8
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  Start exploring     Now try it yourself!    Start exploring and creating.     For additional help, tutorials or information on training sessions, use the Help    menu or go to                                     .    smarttech.com/training   
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